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Module 2 – Building a course that is accessible to all students
This guide is for staff managing or delivering a course in Learn. It looks at the course materials and resource lists that are used for learning and teaching, and is the second in a series of three introductory modules. It covers:
1.	Course Materials
1.1	Lecture recordings
1.2	Using folders to organise course materials
1.3	Adaptive release
1.4	Adding content that is accessible
1.5	Copyright in teaching
1.6	Creating accessible content in Learn
1.7	Uploading files to Learn
1.8	Copying content over from last year to this year
1.9	Resource list
Learn Foundations
To enhance students’ use of the Learn VLE (virtual learning environment), the University is investing in improvements over the next few years that will make it easier for students to find course specific materials and ensure Learn is used more consistently across the University. These improvements are being delivered through a multi-year service improvement programme called Learn Foundations. The Learn Foundations project is introducing minimum standards to Learn through the application of a new structure and more consistent terminology that will make it easier for students to access resources as well as offering training and support to academic colleagues in how to use Learn effectively. These improvements will enable Edinburgh to address accessibility issues and promote positive equality and diversity. The new structure is being offered to all Schools over a three-year period, with around one third of Schools adopting the new structure for the start of teaching 2019/20.
Digital skills training – making the most of Learn 
If your School is adopting the new Learn Foundations structure for Semester 1, you can use the guidelines here to edit items. If you have not adopted the new structure, you can still follow these guidelines to incorporate good practice in your course. The aim is to support all users of Learn with training and resources that can be tailored according to need and enhance the use of Learn.
[bookmark: _Toc16178421]Course Materials
	The Course Materials section is accessible through the middle part of the left-hand menu which contains the learning and teaching content for the course.
The Course Materials section has been designed to store the majority of materials generated or used during the running of the course in one location; this is to help students navigate their course easily. 
A folder structure with weekly or topic-focussed folders provides consistency across courses. Using topics and objectives to describe the folder content makes it easier for students to locate relevant materials.

The Course Materials section:
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[bookmark: _Toc16178422]Lecture recordings
A link to course lecture recordings has been added in the Course Materials section. If the course is in EUCLID then the link will automatically connect to the relevant section in Media Hopper Replay, the University’s media repository where lecture recordings for the course are stored.
If the course is non-EUCLID or the link is deleted then it can be re-created and then enabled. Only the course organiser or secretary of a course can enable the link.
How to add the Lecture Recordings link
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1. Go to a content area on your course
2. Click on Tools and select Media Hopper Replay 
3. In the Name field type Lecture Recordings
4. Click on Submit



How to enable the link from a Learn course to Media Hopper Replay
The link will now connect automatically for any course that is EUCLID created. If the link is deleted or if it is a non-EUCLID course then link to Media Hopper Replay as below. Only the course organiser or secretary of a course can enable the link.
1. Select the Lecture Recordings link.
2. Using the drop-down list under Step 1 - Section, locate and select the course which matches the Learn course you are linking to.
3. Only the course organiser or secretary of a course can create the link.
[image: ]

4. Under Step 2, leave the Link to the Section Home option selected, Select the Link Content button to create the link.
5. When Replay opens, your linked course will be visible, showing any future recordings which have been scheduled. If you have accidently linked to the wrong course, use the Unlink LMS course button below the black menu bar and repeat steps 2 and 3.


The items on the page can be re-ordered, so if Lecture Recordings are not heavily used in a course, you can move this section to below the content folders.
 [bookmark: _Toc6235355]How to reorder content items
This can be done by hovering over the top area of an item, or the purple ‘grab bar’ on the left of an item, until a cross arrow appears and then left-clicking and dragging the item up or down to the desired area on the page. 
Alternatively, click on the ‘Reordering’ icon (up and down arrows) at the top-right of the page, select the item you want to move and then use the up and down arrows to reposition.
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If your course does not use lecture recordings then this link can be hidden. 
[bookmark: _Toc5697575][bookmark: _Toc6235354]How to hide the Lecture Recordings link
1. To hide a content item, access the item’s menu, and select Make Unavailable.

[bookmark: _Toc6235358][bookmark: _Toc16178423]Using folders to organise course materials
The course material should be clearly organised by week, topic or another sensible naming convention; this is to ensure students can easily locate the relevant course material along with providing consistency across courses.
The course materials content area has been pre-populated with a week by week folder structure so that learning resources such as lecture notes, handouts and slides are clearly organised. 
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Within this section, there are eleven separate weekly folders which have been created to host all relevant weekly course materials. More folders can be added if required. 
Being clear about what each folder contains provides students with a clear overview without the need for them to review each folder whilst searching for specific information. Therefore it is recommended that a title, topics and objectives should be added to each folder. 

[bookmark: _Toc6235361]How to add and edit a folder
1. To add a folder, select Build Content, and select Content folder.
2. To edit a content folder, access the folder’s menu, and select Edit. 
3. A WYSIWYG (what you see is what you get) editor pane will open to add and format content.
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4. The editor has text formatting tools and can be made full screen by clicking on the Full Screen icon in the top right of the editor. Clicking on the icon again exits full screen view.
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5. Add a Name to the folder name field (week or topic)
6. Add Topics and Objectives to the text pane. This is the folder information which will describe what the folder contains; the actual content of the folder is not added here.
7. Scroll down to Standard Options and select Yes for Permit Users to View this Content.
8. Track Number of Views if you wish to use the statistics tracking (useful for assignments).
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9. Select Date and Time Restrictions if you wish to use adaptive release features. This can be used to stagger the release of content.
10. Select Submit when editing is finished.
11. After the folder has been created, click on the title to access it and put content inside it.


[bookmark: _Toc6235360][bookmark: _Toc16178424][bookmark: _Toc6235362]Adaptive release
Rules can be set using ‘adaptive release’ to release content to students on a specified date, to specific groups or after a grade has been achieved. Content can also be set to be released after an item has been reviewed. These options can be set from the item options menu by selecting Adaptive Release. Detailed help on setting each rule is available within the adaptive release window. Date criteria can also be set when an item or folder is created. 
All of the folders pre-populated in the structure have been hidden by default as they are empty. They can be made visible to students once content is ready.
If you prefer to organise your content by topic or theme, or combine multiple weeks into single folders, you can remove the example weekly structure and create your own.
Adding Adaptive Release to a folder
1. Click on the action arrow next to the folder title, select Adaptive Release.
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2. DATE You can set dates to display the content from and until
3. Membership Content is only released to specific users or groups, if they exist
4. MARK Content is released if a Mark has been achieved in a Grade Centre column
5. Review Content is released after another item has been marked as reviewed
6. Select Submit to finish.



[bookmark: _Toc16178425]Adding content that is accessible 
All course content that is created in Learn and uploaded to Learn must be accessible to all students. 
Making online courses accessible should not be costly or time-consuming and the best way to ensure accessibility is by making sure your documents and content are accessible before you put them online. This applies to content that is created in the VLE and content that is uploaded. Before uploading a Word document or PDF, check it is accessible by using the tools available in Microsoft Word and Adobe Acrobat Pro. SensusAccess converts documents into alternate formats and more accessible formats.
[bookmark: _GoBack]How to convert documents into alternative formats: SensusAccess
SensusAccess is a self-service solution that enables you to convert electronic documents into a range of alternate formats including audio books (MP3 and DAISY), e-books (EPUB, EPUB3 and Mobi) and digital Braille. Less accessible documents such as image only PDF files, PowerPoint Presentations and JPEG pictures can also be converted into more accessible formats.
More information on SensusAccess can be found by searching the University’s webpages, or using the link below to the Student Disability Service webpages under Supporting students > Accessible technology. 
https://www.ed.ac.uk/student-disability-service/staff/supporting-students/accessible-technology




[bookmark: _Toc6235348]How to use accessibility checkers: Microsoft Word and PowerPoint 
The Microsoft accessibility checker (available in 2013 and later versions) scans the document and opens the Accessibility Checker task pane which shows ‘Errors’, ‘Warnings’ and ‘Tips’ about the document content that may be problematic for users with disabilities.
1. Select the File tab
2. In the info section, select the Check for Issues drop down
3. Select Check Accessibility to launch the task pane
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4. A list of errors and warnings may appear
5. Select an item in the list to see what to fix and how to fix it
6. Select the X in the upper right corner when finished
For more about making documents accessible at the link at the bottom of the accessibility pane.
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How to use accessibility checkers: Adobe Acrobat Pro 
Acrobat Pro provides tools to ‘Make PDFs accessible’ and to ‘Check accessibility’ of documents (available in 2017, DC and later versions). 
The ‘Make PDFs accessible’ action walks you through the steps required to make a PDF accessible. It prompts you to address accessibility issues such as a missing document description or title. It looks for common elements that need further action such as scanned text, form fields, tables, and images. You can run this action on all PDFs except dynamic forms (XFA documents) or portfolios.
1. Choose Tools > Action Wizard.
2. From the Action List, click Make Accessible.
3. The right-hand pane changes to display each task included in the Make Accessible action, as well as the instructions to execute the action.
4. Select the files that you want to apply the Make Accessible action to. Select Add Files to select additional files or a folder to run the action on.

Image-only PDF 
A document that contains non-text content is not accessible. If the document appears to contain text, but doesn't contain fonts, it could be an image-only PDF file. Use optical character recognition (OCR) to recognize text in scanned images.
1. In Acrobat Pro, Select Tools > Enhance Scans.
2. In the secondary toolbar, choose Recognize Text > In This File.
3. Select the pages you want to process and select Recognize Text.
Tagged PDF 
[bookmark: main-pars_text_7]If this rule check fails, the document isn't tagged to specify the correct reading order.
1. Select Tagged PDF on the Accessibility Checker panel, and then choose Fix from the Options menu. Acrobat automatically adds tags to the PDF.
Adobe have online guides with further information on accessible PDFs - search the Adobe support pages for ‘Accessibility’.



[bookmark: _Toc16178426]Copyright in teaching
Content in Learn should adhere to copyright policies.
Open licensed content
The University has an Open Educational Resources (OER) policy that encourages staff and students to use and share open licensed content including OERs and Creative Commons licensed images and media. 
Open educational resources enhance the quality of the student experience, contribute to the provision of learning opportunities for all, and improve teaching practices. The use, creation, and publication of open educational resources is consistent with the University's reputation, values, and mission to "make a significant sustainable and socially responsible contribution to Scotland, the UK, and the world, promoting health and economic and cultural wellbeing".
The OER Service provides advice and guidance to staff and students on finding, creating, and using open licensed content, and understanding open licences.
View the policy at: https://www.ed.ac.uk/files/atoms/files/openeducationalresourcespolicy.pdf
Find out about the OER service at: https://open.ed.ac.uk/
Scanned texts
The University of Edinburgh has a comprehensive CLA (Copyright Licensing Agency) Licence which allows copies of many texts to be made by named, authorised individuals for the purposes of teaching certain courses. These copies must be reported, and so the library manages the use of this licence by providing its E-Reserve service.
Find out about the E-Reserve service at: https://www.ed.ac.uk/information-services/library-museum-gallery/using-library/request-resources/ereserve
Recordings
The University holds an ERA Plus Licence, which enables licensed ERA Recordings to be accessed by students and staff online whether they are on the premises of the University, at home or working elsewhere within the UK. The ERA Licence covers scheduled free to air broadcasts on:
· BBC television and radio
· ITV Network services (including ITV2 and ITV3)
· Channel Four and E4
· Five television
· S4C
· Box of Broadcasts
Images
It can be an infringement of copyright to include copyrighted images in teaching materials without permission. For example, if you wish to include images in slides, you could use images which have been licensed for re-use with Creative Commons, or use one of the University’s image collections. 
More information can be found on Copyright, Open Licensing and OER at: http://open.ed.ac.uk/copyright-and-open-licensing/
[bookmark: _Toc16178427]Creating accessible content in Learn
Content can be created in Learn as items or blank pages. ‘Learning Modules’ can be used to group content into a container and provide navigation to allow students to progress through resources sequentially.
When creating content in the VLE, follow the tips below to ensure content is accessible:
· Chunk large sections of information.
· Use the Formatting and Style options to define headings and lists.
· Font should be size 12 minimum and sans serif font.
· Use a good colour contrast between background colour and font colour.
· Avoid using colour to convey priority of items.
· Explain what folders contain. 
· Links should open in new windows, and this should be clearly stated.
· Use meaningful names for hyperlinks instead of the actual URL.
· If images are added then define alternative text which is clear and succinct.
· Video or other multi-media must include descriptive captions for the content.
· Use accessibility checkers, word and acrobat professional have built in tools.
· Scanned images that are saved as PDFs are not accessible to screen readers. 
Further tips can be found at:
The U.K. Government content design and planning website pages 
The British Dyslexia Style Guide
Content types in Learn
Item: Items can be used to present a combination of content. The functions in the editor allow formatting of the text, files attachment, embedding of multimedia, insert equations, links, and tables. 
File: A link to a file in the content list. A description cannot be added with the link, therefore it is not accessible practice to use this method to add files. See the section on How to upload a file to Learn for the accessible method to add a file.
Image: Images appear on the page.  Do not only use images to convey any important text information as these are not accessible. Use alternative text descriptions to give a clear and succinct description of what the image is for screen reader users. Alt text defines what this file is for a visually impaired or blind user using assistive technology, such as screen readers. 
Web link: A link to an outside website or resource. Use a meaningful name for the link.
Learning Module: A learning module is a content container that allows students to navigate through the content from a table of contents. You can add all types of content, such as content items, file attachments, links to websites, tests, assignments, and multimedia.
Course Link: A link to another part of the course.
Content Folder: Use folders to organize content and help students find materials easily.
Blank Page: Blank Pages can include files, images, and text together on one page.

[bookmark: _Toc6235364]How to add course content
1. Hover the mouse over Build content and select the content type you require. Follow the steps as below. 
2. Select Submit when finished.

Add an item: 
· Name - give the Item a meaningful name. 
· Text - add and format the text.
Add a file:
· Use a meaningful name for the file as alt txt cannot be added by this method.
Add an Image: 
· Name – give the image a meaningful name.
· Find File – browse to find the image, Select file, and click Open. 
· Alt text – All image files should have alt text associated for a visually impaired or blind user using assistive technology, such as screen readers.
· Long Description - a description of the image for people who cannot see the image.
· Image options  
· Dimensions set to Original. 
· Border box, select 2 to add a two pixel border to the image. 
· Set open in New Window to No. 
Add a Web link: 
· Name - Give the link a meaningful name.
· URL – add the URL.
· Description- state that the link will open in a new window here.
· Open in new window - set to Yes.
Add a Learning Module:
· Name - Give the module a meaningful name.
· Text- give a description of what the learning module covers.
· Enforce sequential viewing – set to Yes
· Open in New window – leave as No
Add a Course Link: 
· Click the Browse button and select the destination to be linked to. 
· The content remains in its original position, you have created a link to it.
Add a Blank Page:
· Name - Give the page a meaningful name as no description can be added.
· Content – use the editor functions to format text, attach files, etc.
· Attachments – files can be attached



[bookmark: _Toc6235365]

[bookmark: _Toc16178428]Uploading files to Learn
Good practice: add an item and insert a file as this allows for alternative text (‘alt text’) to be added. Alt text defines what this file is, and is particularly helpful for a visually impaired or blind user using assistive technology such as screen readers.
How to upload a file to Learn
1. All content uploaded to the VLE must be accessible so before uploading a file, check that it is accessible (see ‘How to use accessibility checkers’ guidance on the following pages).
2. Select Build Content, then Select Item.
3. Select Insert File from the formatting toolbar on the editor.
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4. Use the Browse options to attach the file.
5. Give the link to the file a meaningful name.
6. Add alternative text to describe the purpose of the file.
7. Select Submit when finished.
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[bookmark: _Toc16178429]Copying content over from last year to this year
There may be content in a previous year’s course that is to be reused. Content items, folders and learning modules can all be copied from one course to another using a few simple steps. If files are included in the content being copied, it is recommended to select the option in the process which will make copies of these files.
[bookmark: _Toc6235366]How to copy content from one folder to another
1. Go to the item, folder or learning module to be copied.
2. Access the item’s menu, and select Copy.
3. Use Browse to choose the destination course and folder. If files are included in the copied content, select Include links and make copies of attached and embedded files. 
4. Select Submit.
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How to copy an entire content area over to another course
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1. On the left menu, under Packages and Utilities select Course Copy
2. To find the Destination Course ID select Browse select the course from the list
3. Under Select Course Materials select the content area to be copied over
4. Click on Submit


[bookmark: _Toc6235356][bookmark: _Toc16178430]Resource list 
Resource Lists are online reading lists. Resource Lists provide students with easy access to key reading materials including eBooks and copyright-compliant digitisations. Course organisers can request library resources via Resource Lists.
The key benefits of the Resource Lists service are:
· Benefits to students: to provide and facilitate access to key course materials and, as a result, improve the student experience:
· Key resources become more accessible to students: students spend more time reading items on their lists than searching for them.
· Students can quickly see which items are essential reading: Resource Lists help students to prioritise their reading.
· Improved discovery of resources: students are introduced to key resources and signposted to further reading.
· Benefits to academics: to simplify and streamline access to library services, saving time and better supporting learning and teaching.
· Create your list in 10 simple steps or ask the Library to create one for you. 
· Ensure that the Library is aware of resources used in teaching and can provide access electronically or in print.
· Accessible and inclusive learning: using Resource Lists enables students to prioritise readings and complies with the University's Accessible and Inclusive Learning Policy.
The Resource List link will be visible by default in schools with over 50% current usage of this tool. Where a school has less than 50% current usage it will be set to unavailable and will need to be set to visible on a course by course basis when used. 
If a course uses its own list, then the Resource List menu link should be made visible in the left menu, and the reading list added to the content area.
If a course does not use any Resource List at all, and is in a school where the Resource link is on by default, then the link can be hidden by following the same steps in ‘How to make the Resource List link visible’ below, and selecting Hide Link.


[bookmark: _Toc6235357]How to make the Resource List link visible
1. First, check your Resource List is associated to the corresponding course code. 
2. In the left-hand menu, a square box with a line beside the menu title indicates it is not visible.
3. In the left hand menu, select the drop-down arrow to the right of Resource List.
4. Select Show Link from the menu options.
5. If the link is already visible then Hide Link will appear in the menu.
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6. Click on the Resource List link in the navigation to access the Resource List content area. 
7. Click on the arrow to the right of Resource List, Select Edit
[image: ]

8. Under OPTIONS, Select Yes for Permit Users to View this Content.
[image: ]

9. Select Submit to make the list visible to students.
Please note: you will not be able to click through to the Leganto list in ‘student view’, but if you can see the Resource List link and are able to click through to the reading list as an instructor, the link will be working for students.



If you require this document in an alternative format, such as large print or a coloured background, please phone Paul Smyth (Learning Technology Advisor) on 0131 651 1261 or email LearnFoundations@ed.ac.uk
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